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Introduction
The Test Drive document contains illustrative examples of the nanoCAD Platform capabilities.

This guide is divided into two parts. The first part is designed for beginners. It allows users to get
acquainted with the nanoCAD Platform without any prior training. The second part is designed for
advanced users, as it explains the functionality of unique CAD instruments.

We have prepared special exercises and step-by-step instructions for their implementation. The
practical skills gained through these exercises will allow users to switch easily to independent work
in nanoCAD.



Contents
Standard Drawing 4

Editing 10

Design 20

Working with Layout 24

Creating Transmittal Package 28

Part 2. Unique Functionality of nanoCAD 31

Comfortable Printing 31

Drawing Explorer 35

File Explorer 37



Part 1. For Beginners
This part explains the basic CAD functionality: drawing, editing, dimensioning, and working
in paper space.

1. Standard Drawing

Open the Steel Bar.dwg file from nanoCAD Platform Test-Drive / 1 Standard drawing
folder.

Press F8 or type ORTHO in the Status bar to turn on the orthogonalization mode.

Press F12 or type DYN in the Status bar to turn on the dynamic mode.

1.1. Run the Polyline command (fig. 1):

Fig. 1. The Polyline command

1.2. Use the red X as the base point.

1.3. Start drawing the polyline from the base point. Type the distance 16 (fig. 2):



Fig. 2. Dynamic input

1.4. Move the cursor to the right to draw the next point, and type the distance 40 (fig. 3):

Fig. 3. Dynamic input

1.5. Continue drawing.

As a result, you should get a rectangle (see the fig. 4).



Fig. 4. The result

1.6. Turn off the Auxiliary Layer (fig. 5):

Fig. 5. Turn off the Auxiliary layer

1.7. Click on the Circle – Center, Radius (fig. 6):



Fig. 6. Circle by Center and Radius

1.8. Draw a circle with a radius of 14 (fig. 7):

Fig. 7. Draw a circle

1.9. Use the Smart Trim command to remove unnecessary lines (fig. 9 and 10):



Fig. 8. The Smart Trim command

Fig. 9. Use the Smart Trim command

1.10. Change the radius of the big circle: select the circle and click on the vertices (fig. 10).
In the dynamic field type 30:

Fig. 10. Change the circle radius

1.11. Set the Dimensions layer as current.



Use the Dimensions command (fig. 11) to enter dimensions.

Fig. 11. Dimension commands on the ribbon

That’s all, the fig. 12 displays the final result.

Fig. 12. The final result



2. Editing

Open the Facade.dwg file from the nanoCAD Platform Test-Drive / 2 Editing folder.

2.1. In the Properties, choose 3D Wireframe for the Visual Style (fig. 13):

Fig.13. Change the visual style

2.2. Turn off the visibility of the Shadow and Column layers. The visibility of layers can be
changed by the bulb icon next to the layer name.

2.3. Select all objects with a Fence. Then use the Mirror command located on the ribbon:
Draw – Modify – Mirror (fig. 14).



Fig. 14. The Mirror command

Use the red line as the axis of the mirror. Do not erase source objects. We do not mirror
shadows and columns because they look different on the left and the right sides of the
facade.

Fig.15. Mirroring

The result should be as shown in fig.16:



Fig. 16. The result of mirroring. General view of the façade

2.4. Turn on the visibility of the Columns layer and make it current. To make the layer
current, just left-click on it.

2.5. Turn off the visibility of the Solids layer.

We use additional grey-green gradients for a more realistic view. We have created
gradients on the right side of some columns to simulate shadows.

The result should be as shown in fig. 17.



Fig. 17. Intermediate result

2.6. Create shadows for the columns in any convenient way. Below is one of them.

Turn on the visibility of the Auxiliary layer. Select the following gradient by a left-click (fig.
18):

Fig.18. Gradient to copy

Run the Copy command. Specify the base point on the column, see the fig. 19:



Fig. 19. Base point for copying

Paste this gradient on the right side of the top columns (fig. 20):

Fig. 20. Copy gradients for the top columns

Repeat the actions for the bottom columns (fig. 21):



Fig.21. Copy gradients of the bottom columns

Turn off the visibility of the Auxiliary layer.

Keep three columns without gradient (fig. 22):

Fig. 22. Columns without gradient

2.7. Working with gradients.

Please note that the center of the building has incorrect gradients due to the Mirroring (fig.
23):



Fig. 23. Incorrect gradients

2.8. Edit these gradients. Double click on one of them, then swap two colors in the
Gradient tab of the Hatch dialog box (fig. 24):

Fig. 24. Swap colors in the gradient

Do the same with the second incorrect gradient.

2.9. Add a new gradient to the building's top and bottom.



First, you set the Additional gradients layer current. Next, call the Gradient command on
the Annotate tab (fig. 25):

Fig. 25. Choose gradient colors.

Set the following values: Color 1 = 83, Color 2 = 127,176,178.

Choose the Cylinder + Inversed gradient type.

Add two pick points (fig. 26):

Fig. 26. Gradient pick points

To speed up the gradient outline, select as close as possible, but make sure that the
borders fit the screen.

As a result, you get a bright, saturated color of the gradient. To make it the same as other
gradients, select this gradient and set Transparency = 80 in the Properties (fig. 27):



Fig. 27. Change transparency of the gradient

2.10. Set the correct gradient display.

2.10.1. Set the Main layer current.

2.10.2. Turn off the visibility of the Additional gradients layer, and select all objects
with a Fence.

2.10.3. In the Properties, choose Hatch in the Object type field (fig. 28):

Fig. 28. Select only hatch

Move the selected hatches to the background: right-click on the workspace – Display
order – Send to back.

2.11. Turn off the visibility of the Columns layer.



2.12. Turn on the visibility of the Shadows layer and set it current.

2.13. Turn on the visibility of the Right shadows layer. We finished the rest of the shadows.
The result should be as shown in fig. 29:

Fig. 29. The final display of shadows on facade

2.14. Complete the drawing.

Delete the middle red line. Turn on the visibility of the following layers:

● solids
● additional gradients
● columns
● final

2.15. The facade is finished. The final result should be as shown in fig. 30:

Fig.30. Final view of the Facade



3. Design

In this part, we will add benchmarks and dimensions to the drawing.

Open the Faсade Desing.dwg file from nanoCAD Platform Test-Drive / 3 Design folder
(fig.31):

Fig. 31. The Facade Design.dwg drawing file in nanoCAD

3.1. Make the Design layer current.

3.2. Add a dimension between axes: Annotate – Dimension – Aligned – enter dimension
between two axes on the drawing (fig. 32):



Fig. 32. Dimension

3.3. Set the dimension style. Click on the Design tab and open the Dimension Style dialog
box (fig. 33):

Fig. 33. Run the Dimension Style Manager

Select the current dimension style and click Modify (fig. 34):



Fig. 34 Dimension Style Manager

In the Lines tab, configure the following settings:

● Color of Dimensions lines – white
● Color of Extension lines – white

In the Text tab set the text color as white (fig. 35):

Fig. 35. Edit the dimension style



Click OK, then close the Dimension Style Manager.

3.4. Insert a block with a benchmark.

Run the Insert Block command in the Insert tab. Press the Browse button and select
Bechmark.dwg file from nanoCAD Platform Test-Drive / 3 Design folder (fig.36):

Fig. 36. Insert block from the file

Click OK. Insert the block three times and add attribute values as shown in fig. 37:

Fig. 37. Final drawing.



4. Working with Layout

Continue working with the Facade Design.dwg file from the nanoCAD Platform
Test-Drive / 3 Design folder or open the Facade Work with Layout.dwg file from the
nanoCAD Platform Test-Drive / 4 Work with layout folder.

4.1. Open A3 layout and add a title block.

We will insert an external reference with the title block.

Insert – DWG Reference: choose Title Block.dwg file, click Open, then OK. You can snap
the title block to the bottom left point of the layout (fig. 38):

Fig. 38. Insert external reference

4.2. Create a view of the layout.

Let’s choose a rectangular viewport (fig. 39):

Fig. 39. Add viewport

Specify the viewport borders with the left-click. Input the view scale 0.01. Select the
viewport and specify the 3D Wireframe visual style in the Properties bar (fig. 40):



Fig. 40. Viewport on layout

4.3. Work with fields.

Set the author’s name: click nanoCAD – Utilities – Drawing Properties (fig. 41). Open the
Summary tab and type any name into the Autor field. Click OK.



Fig. 41. Drawing Properties

4.4. Press the Field button on the Insert tab of the ribbon.

In the new Field dialog box select the Author field (fig. 42):



Fig. 42. The Field dialog box

Click OK and specify an insertion point (fig. 43):

Fig. 43. Inserted field

The value of the field is changeable. If you change the author’s name or insert this field into
another document, the value will be changed.



5. Creating Transmittal Package

The eTransmit command allows you to collect all the data related to the current drawing
(shx fonts, external references, underlays, etc.), and save it to the .zip archive. The archive
can be sent to colleagues or clients. It can reopen on another computer with no problem.

Continue your work with the drawing file from the Work with Layout topic or open the
Facade eTransmit.dwg file from the nanoCAD Platform Test-Drive / 5 eTransmit folder.

5.1. Open the External References toolbar (fig. 44):

Fig. 44. The External references toolbar

The current drawing file includes one external reference now. If you send someone only the
current drawing file, they will not be able to see an external reference.

5.2. Click on the nanoCAD button – ETransmit (fig. 45):



Fig. 45. The ETransmit command

A new window will display a list of transmittal elements including the current drawing,
external reference, font, etc. (fig. 46). You can uncheck files you don’t want to transmit:

Fig. 46. The Create Transmittal window

Click OK and specify the path for saving. Save the file.

5.3. Close the drawing file in nanoCAD.

5.4. Unzip the transmittal archive and open the drawing file (fig. 47 – 48):



Fig. 47. Unzipped archive

Fig. 48. Drawing file from the unzipped archive

The drawing file is displayed correctly with no elements
lost.



Part 2. Unique Functionality of nanoCAD

We develop the nanoCAD platform by taking into account users’ feedback. Thanks to this,
the new versions include unique functionality that you will not find in any other CAD system.

6. Comfortable Printing

It is difficult to make the CAD printing process simple and intuitive, as there are many
different settings and characteristics to consider, such as rotation rules, alignment rules,
print margins, and many others. Nevertheless, we made the plotting as convenient as
possible.

By choosing the paper size and plotter, we can accurately align the image, while having a
physical sheet of paper with dimensions, orientation, and print margins in front of our eyes.
In addition, we can fit a drawing to the paper and thus reduce paper consumption if the
drawing is output on rolls. A visual icon in the upper corner will show how the paper will
come out of the plotter. It is also possible to switch to the preview mode to see how plot
styles are applied to the drawing.

Open the Plot.dwg file from the nanoCAD Platform Test-Drive / 6 Plot folder.

6.1. Plot from the paper space to Internal PDF Printer (fig. 49).
Open an A3 layout.

Fig. 49. Paper space

6.3. Click the Plot button in the Quick Access bar (fig. 50):



Fig. 50. The Plot command

6.3. Use the Internal PDF Plotter. Set A3 paper size, 1:1 scale. Select the Show Page
Preview option. Specify the Plot Style table – monochrome.ctb (fig. 51):

Fig. 51. The Plot manager

6.4. Click the Plot button. Choose the folder and then click Save.

As a result, you will get a document in the .pdf file format (fig. 52):



Fig. 52. Drawing in PDF

6.5. Align layout

Now we will plot the drawing on the physical printer. Go to the Model space, and choose a
printer. Select the Paper Size: A2, the Plot area – Window. Click the New window print
area button, then specify the print area on the drawing (fig. 53):

Fig. 53. Plot settings

Choose a printer and select the Show Page Preview option. You will see that the drawing



includes margins. Select the Fit to paper option: it allows you to adjust the plot area scale
so that it perfectly fits the page of the current format (fig. 54):

Fig. 54. The Fit to paper option

Click the Plot button: you will get the same result as it was on the preview.



7. Drawing Explorer

The Drawing Explorer provides full information about all the drawing objects: graphic
objects; block references, external references, raster images; as well as parameters of the
drawing settings. The Drawing Explorer allows you to not only understand what objects
the file contains, but also find them quickly in the drawing, select, zoom in, and delete them
if needed. All proxy objects of the drawing are collected separately, and, when selected,
they indicate in which CAD systems they were created. Blocks, xrefs, raster underlays
collected in the current document, layers, text and dimension styles, named views, layouts
are clearly displayed.

Open the Drawing Explorer.dwg file from the nanoCAD Platform Test-Drive / 7 Drawing
Explorer folder.

7.1. Open the Manage tab and click the Drawing Explorer (fig. 55):

Fig. 55. Drawing Explorer

7.2. Specify the entities in the Drawing Explorer: Displaying – Model – Entities.

Open the AecDbWall list and select different objects from this list with a double-click.
nanoCAD will display the selected objects (fig. 56).



Fig. 56. Selected proxy object

nanoCAD provides the command set to work with proxy objects including their explode.

7.3. Open the Drawing Settings section in the Drawing Explorer. This section allows you
to control the layers, blocks, styles, and layouts in the current drawing.

7.4. Open the Displaying – Entities – Line section, then draw a line anywhere in the
drawing file. The line will appear in the Drawing Explorer (fig. 57):

Fig. 57. A new line

Just like that, the Drawing Explorer allows you to control your drawing file.



8. File Explorer

The File Explorer allows customers to find elements of different drawing files and insert
them into the current drawing without opening the file with elements.

8.1. Open nanoCAD and create a new drawing file.

8.2. Manage – Palettes – File Explorer (fig. 58):

Fig. 58. File Explorer location in the Ribbon

Expand the File Explorer window as shown in fig. 59:

Fig. 59. Expand the File Explorer

8.3. Find the Plot.dwg file in the nanoCAD Platform Test-Drive / 6 Plot folder. Click
Blocks (fig. 60):



Fig. 60. Explore the Plot.dwg file

8.4. In the Blocks section select Block, right-click on it, and choose the Insert block(s)
option (fig. 61):

Fig. 61. Insert the block

8.5. Insert the block into the 0,0,0 location and click OK. After the insertion press the Alt+0
combination or double click on the mouse wheel: it will show all the objects on the drawing.

8.6. Insert the A4 layout from the Plot.dwg file in the current drawing.

Now the File Explorer allows you to add blocks, layouts, external references, text styles,
dimension styles, layers, and line types from other drawings to the current one.


